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Using Adobe Photoshop 

5 ï Selection 
When you are working with raster images, it can be difficult to select the 

part of the image you need to edit. That is because your computer wonôt be 

able to distinguish between different parts of the image and will only see it as 

a collection of different coloured pixels. For this reason, knowing how to select areas 

in an image is crucial to being able to work effectively in Photoshop. Fortunately, 

Photoshop provides a wide range of tools to make the task simpler. 

Several marquee tools are available for selecting shaped areas in an image. A range of lasso 

tools can be used for selecting less regular shapes. Other tools such as the magic wand tool and 

selection masks make it possible to be very precise in what parts of the image you select. 

1 -  Selection Marquees 

Photoshopôs tool panel provides four selection marquee 

tools. A selection marquee is an outline that is created 

around a certain part of an image. That part of the image can 

then be copied, coloured etc without affecting the rest of the 

image. The four standard marquees are described below. 
Rectangular Used to select rectangular shaped areas. Holding down [Shift] while you 

select will force a symmetrical square shaped area. Holding down [Alt] 

while selecting selects from the middle outwards. 
Elliptical Used to select elliptically shaped areas. Holding down [Shift] while you 

select will force a symmetrical circle shaped area. Holding down [Alt] 

while selecting selects from the middle outwards. 
Single Row / Column Used to select a single line of pixels either horizontally or vertically. 

The Marquee tool is selected with the [M] key. You can use [Shift] [M] to switch between the 

rectangular and elliptical marquee tool. 
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Exercise 1 ï  Using Selection Marquees 

1) Open the file called Selections.png. This image contains several shapes that we can use as 

practice in selecting parts of the image. 

 

2) Select the Rectangular Marquee Tool by clicking on the 

icon  or by pressing [M]. Your mouse will change to a 

cross shape + when it is over the picture. 

3) Move your mouse to the top corner of the rectangle in 

the picture. 

4) Drag to the opposite corner to select the rectangle. A moving outline will surround the 

selected area. 

5) From the View menu select Extras or press [Ctrl] [H]. The area is still selected but the 

marquee border has been hidden which can be handy if you donôt need it showing. 

6) Press [Ctrl] [H] to show the selection marquee again. 

You can cancel a selection by clicking outside the selected area, though that is a bad habit to get 

in to since itôs generally not a good idea to click on your picture without a specific reason and 

can cause problems in certain situations. A better way is to use the deselect command. 

7) From the Select menu select Deselect or press [Ctrl] [D]. 

 
Tip Photoshop has a lot of keyboard shortcuts but some shortcuts for frequently needed tasks such 

as Deselecting [Ctrl] [D] are well worth remembering as they can save you a lot of time. 

 

8) Try selecting other rectangular areas while holding down the [Shift] key, the [Alt] key and 

both at the same time. 

9) Use the [Ctrl] [D] shortcut after each one. 

10) From the Tool Panel, switch to the Elliptical Marquee Tool by holding your mouse on the 

Rectangular Marquee Tool icon and then clicking the Elliptical Marquee Tool icon, or by 

pressing [Shift] [M]. 

Rectangle shapes are easy enough to select from one 

corner to another but not ellipses since they have no 

corners. It isnôt as hard to estimate the centre of an ellipse 

though so selecting from the centre out using the [Alt] key can be a lot simpler. The circle in the 

Selections image has a spot in the centre to make it easier. Because we want to select a perfect 

circle shape, we will need to hold down the [Shift] key as well. 

11) Move your mouse over the spot in the middle of the circle. 



Using Adobe Photoshop CC2017  Selection 

É Steve OôNeil 2017 Page 3 of 32 http://www.oneil.com.au/pc/ 

12) Hold down the [Shift] and [Alt] keys and then drag outwards until the circle is selected. 

 

13) If your selection wasnôt quite centred, move your mouse inside the selected area and drag to 
reposition it. You can also use your arrow keys on your keyboard to nudge it a small amount 

in any direction you need. 

14) Leave the circle selected. 

2 -  Moving / Copying a Selected Area 

When you have part of your image selected, you can move or copy it to other parts of the image. 

You can even copy it to other layers (explained in the next section) or to another image. Be 

aware though that if you move / copy it to another part of the image, it will replace the pixels in 

that part of the image. The part of the image you move it over canôt be recovered without the use 

of Undo or History features. 

Exercise 2 ï  Using the Move Tool 

1) Select the Move tool by clicking the icon on the Tool Panel  or press [V]. Your mouse 

will change shape when you move it over the image.  

2) Move your mouse inside the selected area. A picture of a pair of scissors will appear next to 

the mouse to indicate that dragging will cut (move) the selected part of the image.  

3) Drag the selected area in to the orange area at the bottom of the image. The area left behind 

will be filled with your selected background colour (or left empty if you are working in 

layers as you will be later). 

4) As long as the selection marquee remains around the circle you will still be able to move it 

freely. Move it around the orange area some more. 

5) As soon as the circle is deselected, it will replace whatever pixels it is on top of. Press [Ctrl] 

[D] to deselect the circle. The orange pixels in that part of the image are now replaced with 

the pixels of the circle that was selected. 

6) Select Elliptical Marquee tool and select the circle again (remember Alt to select from the 

centre and Shift to keep height and width the same for circle shaped selections). 

7) Select the Move tool and move the circle again. The area you move the circle from will again 

be filled with the background colour. The orange pixels are gone. 

8) Press [F12] or select Revert from the File menu to revert the image to its saved state. 

 
Tip Holding the [Alt] key while using the move tool will mean you will copy the selected area instead 

of moving it.   
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Exercise 3 ï  Copying and Temporarily using the Move Tool 

1) Select the Rectangular Marquee tool and select the rectangle shape. 

Just as you can temporarily select the Move and Zoom tools using shortcuts, you can also 

temporarily select the move tool by holding down the [Ctrl] key while another tool is selected. 

2) Hold down [Ctrl] to temporarily select the Move tool. 

3) Hold down the [Alt] key as well as the [Ctrl] key to change the move tool to copying mode. 

4) Drag the rectangle down to the orange area at the bottom of the image. This time a copy of 

the selected rectangle will be left behind instead of being filled with the background colour. 

 
Tip Holding down the [Shift] key as you drag will restrict movements to either vertical or horizontal 

depending on which way you move your mouse. 

 

5) With the rectangle still selected, press the arrow keys on your keyboard to move the selected 

area by a small amount in each direction. This can be an easy way to make fine adjustments 

to your positioning. 

6) Move the rectangle in to the position shown below and then press [Ctrl] [D] to deselect it. 

7) Press [Ctrl] [Shift] [S] for Save as. 

8) Save the image as a Photoshop PSD file named Selections.psd. 
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3 -  Selection Lassos 

Photoshopôs lasso tools allow you to select areas that arenôt a regular shape. There are three 

lasso tools. The regular Lasso tool allows you to make freehand selections. The Polygonal Lasso 

tool is used to make straight edged selections. The Magnetic Lasso tool combines the features of 

the lasso tool with the features of the Magic Wand tool (explained on page 4 - 9). You can select 

the Lasso tool with the [L] key and you can switch between the lasso tools using [Shift] [L].

  

Exercise 4 ï  Using the Lasso Tool 

1) Zoom in so that you can clearly see the front of the car ( Ctrl + and spacebar to reposition ). 

 

2) Select the Lasso tool by clicking the icon on the Tool Panel  or by pressing [L]. Your 

mouse pointer will change in to a lasso shape when it is over the image. 

To select using the lasso tool, you need to make sure that the small arrow of the lasso is over the 

area you want to begin selecting from. 

 

3) Move your mouse over the top corner of the left headlight. 

 

4) Carefully drag around the border of the headlight to select it. 
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5) Selecting areas of the image can be difficult with an unusually shaped mouse pointer. Press 

the [Caps Lock] key to change the mouse pointer to a crosshair shape. The mouse pointer 

will stay in this shape for as long as Caps Lock is turned on and will also work with many of 

Photoshopôs other tools. 

6) Press [Ctrl] [D] to deselect the headlight and then try it again with Caps Lock turned on. 

If you donôt go all the way around the shape then your starting and finishing points will be 

joined by a straight line to complete the selection. 

Selections can also be refined by adding and subtracting areas. If you select while holding down 

the [Shift] key you will be adding to what is selected. If you select while holding down the [Alt] 

key you will be subtracting from what is selected. 

7) Hold down the [Alt] key and select the yellow part of the headlight. Since we are removing 

from the selection, it doesnôt matter if you stray in to the red area. In fact, itôs a good idea to 

do just that to make sure you donôt miss any of it. 

  Ą   Ą   

8) Hold down the [Shift] key while selecting the same section of the other headlight. You might 

want to turn on [Caps Lock] while you do it. 

 

9) Press [Ctrl] [H] to temporarily hide the selection marquee (the headlights will still be 

selected) 

10) Set your foreground colour to a blue colour 

 

11) From the Edit menu select Fill or press [Shift] [F5]. 

12) In the Fill dialog set the following options. 
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Because we have an active selection, only the selected areas of the image will be affected by the 

fill.  

13) Click OK to add the fill. The middle section of the headlights should now have a light blue 

tint. 

14) Press [Ctrl] [H] to redisplay the selection marquee and then press [Ctrl] [D] to deselect the 

headlights. 

 

15) Press [Ctrl] [S] to save the changes to the file. 

16) Press the [Caps Lock] key to change the mouse pointer back to its normal shape if it has been 

turned on as the crosshair might not be so helpful when you are using other tools (or if you 

start to type). 

17) Change the view to 100% magnification (you can use the [Ctrl] [0] shortcut). 

 
Tip The [Shift] and [Alt] keys can be used with any selection tools. If you make a selection using 

one of the tools such as the Rectangular Marquee, you can add or subtract from the selection 
using a completely different selection tool. Holding down [Shift] and [Alt] at the same time will 
select the intersection of an existing selection and your new selection. 

 

18) Practice selecting areas of the image using each of the selection tools you have used and 

using the [Shift] key, the [Alt] key and both together. 

 

While you have a selection tool active, you can also use icons on the Options Panel to turn on 

options for controlling what will be selected when you use the tool. 

 Creates a new selection 

 Adds to an existing selection 

 Subtract from an existing selection 

 Intersect with an existing selection 
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Exercise 5 ï  Using the Polygonal Lasso Tool 

1) Switch to the Polygonal Lasso tool by selecting it from the Tool Panel or by pressing  

[Shift] [L]. 

2) Click in one of the corners of the star shape. 

 

3) Click in the middle of the top section. 

 

 

4) Move around the rest of the shape, clicking on each corner. When you return to the starting 

point, a small circle will appear next to your mouse pointer to let you know you can 

complete the selection. Click when you are at that point to complete the selection.  

 

5) Hold down [Ctrl] and [Alt] and then drag the selected shape to place a copy of it in the bottom 

section of the image. 

 

6) Press [Ctrl] [D] to deselect the copied shape. 

7) Press [Ctrl] [S] to save your changes. 
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4 -  Smart Selection Tools 

Photoshopôs magic wand tool can be used to select areas of a similar colour in the image. While 

it is being used, you can click on a part of the image, and all areas that have a similar colour will 

also be selected. 

The most important option with the magic wand is the tolerance options. Remember that each 

channel in an image has 256 shades. The tolerance can be any value from 0 to 255. If a lower 

number is set for tolerance, then only colours that are very close to the colour of the pixel you 

click on will be selected. With a higher tolerance more will be selected. With a tolerance of 0, 

only colours exactly the same as the pixel you click on will be selected. Sometimes you may 

need to try it a few times with different tolerance amounts before you get it right. 

The Magnetic lasso tool works like the regular lasso tool, except that the selection will follow 

parts of the image where there is a sudden change from one colour to another. 

Exercise 6 ï  Using the Magic Wand Tool 

1) Select the Magic Wand tool by clicking the icon in the Tool 

Panel or by pressing [W].  

2) In the Options Panel at the top, set the tolerance to 15. 

3) Click inside the rectangle shape to select it. 

4) In the Options Panel turn off the Contiguous option . This will mean that all similarly 

coloured areas of the image will be selected, not just adjacent areas. 

5) Deselect the rectangle and then click on it again. Now all similarly coloured areas will be 

selected. 

6) Turn the Contiguous option back on. 

7) Click on the windscreen of the car. Only part of it will be selected. 

8) Change the tolerance to 60 and try again. It should all be selected now depending on which 

part of the windscreen you clicked on. 

 

9) Select the Rectangular marquee [M] and make a rectangular selection around the whole car. 

10) Switch back to the magic want tool [W]. 

11) Hold down [Alt] and click inside the area around the car to remove it from the selection. 

Now the only the car should be selected. 

 Ą  

12) Copy the car to the bottom area of the image (Ctrl Alt and drag), deselect and save the 

changes to the file. 
Note When you use some Photoshop tools such as the magic wand, the options will remain on 

whatever settings you used the last time you used that tool   
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Exercise 7 ï  Using the Quick Selection Tool 

The quick selection tool allows you to select a range in your picture by dragging across it ï even 

if not all the parts you drag across are the same colour. Weôll use the Quick Selection tool to 

select parts of the car.  

1) Select the Quick Selection Tool (It is grouped with the 

Magic Wand tool)  

2) Move your mouse over one of the red parts of the car 

towards the back of the car. 

 

3) Drag your mouse across other red parts of the car. When your mouse moves over black lines 

and different shades of red they will all also be selected. Try to select all the red areas and 

connected areas as shown below. 

 

In the options panel you will see 3 icons allowing you to choose whether you are making a new 

selection, adding to your selection or subtracting from your selection. The option to add to a 

selection may already be selected (if it isnôt you can hold down [Shift] to temporarily enable it). 

 

4) With the add to selection option active, you can click red parts of the car you may have 

missed to add them to the selection. 

5) With the Subtract from selection option or with the [Alt] key held down, click on any extra 

parts of the car you may have accidentally selected to remove them from the selection. 

6) Save and close the Selections file.   
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Exercise 8 ï  Using the Magnetic Lasso Tool 

The Magic Wand tool is useful when you are selecting areas that are a similar colour as seen in 

the earlier exercise. Itôs not so useful when there are no such areas. This is where the Magnetic 

Lasso comes in handy (the quick selection tool could also be used but itôs not as precise). 

1) Open the image called park.jpg. We will use this image as the background for another image 

that we will work with. 

2) Open the image called portrait.jpg. 

 

We need to select the boy so we can copy him in to the other image. There are no obvious areas 

to use the magic wand tool with and tracing around the subject with the Lasso tool would 

require an unreasonable amount of precision. The Magnetic Lasso provides an ideal solution. As 

you trace around an area with this tool, the selection marquee will snap on to areas of the image 

where there is a sudden change in contrast. 

3) Selecting an irregular shape like a human in a photo requires a lot of precision which is 

easier at higher magnification. Zoom in on the picture so you can see a close up view of the 

area shown below. 
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4) Select the Magnetic Lasso tool from the Tool Panel or from 

the [Shift] [L] shortcut. 

5) Take a look at the options available in the Options Panel. 

You will notice three settings in the middle of the panel. In 

some cases you may need to change these options to 

improve your results with the tool. 

 

Width How far from your current position Photoshop will check for colour changes. 

Edge Contrast How much difference in colour there needs to be before the tool detects the change. 

Frequency How frequently Photoshop will add fastening points. 

6) Click on a point along the edge of the area you want to select. 

 

7) Slowly move the mouse around the edge of the area you are selecting. There is no need to 

hold the mouse button down. A selection marquee will follow the outline based on the 

colour contrast between the area you are selecting and the surrounding area. At regular 

intervals, Photoshop will place Fastening Points, small dots which indicate anchor points for 

the selection. If you want to make sure the selection goes along a certain path (such as when 

you get to a corner) you can click to place your own fastening points wherever you need 

them. 

 

Note Using this tool can be difficult at first for some people. If you have a hard time, press [Esc] to 
cancel and then try again and youôll soon get the hang of it. 

You may need to 
click to make sure 
a fastening point is 
placed in spots like 

these. 
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8) If you accidentally get a fastening point where you donôt want one, press [Del] to remove the 

last point placed (pressing [Esc] will cancel completely if needed so you can start over 

again). Donôt worry if itôs not too exact. We can neaten up the selection later. 

9) When you reach the edge of the window, hold down [Space] to switch to the hand tool. Then 

you can move the image, allowing you to continue selecting around the edge. 

 

10) It can take a long time but it gets easier with practice. Continue tracing all the way around 

the outline of the boy until you reach the bottom of the picture. 

 

Unwanted fastening 
points can be easily 
removed. Press [Del] 
until you get back to 
the last good point and 
then continue making 

your selection. 
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Tracing along the bottom of the image wonôt give a very good selection since there is no 

obvious line to follow. While you are using the Magnetic Lasso tool you can temporarily select 

either of the other Lasso tools. Clicking while holding down [Alt] will temporarily engage the 

Polygonal Lasso tool. Dragging while holding down [Alt] will temporarily engage the regular 

freehand Lasso tool. 

11) Hold down [Alt] and click on the bottom right corner of the area we are selecting to 

temporarily turn on the Polygonal Lasso. 

 

12) Move the mouse across to the bottom left corner and click to create a straight lined selection 

across the bottom (You can hold down [Space] and use the hand to move across). 

13) You should now be back near your starting point. You can press [Enter] to close up the 

selection area or if you want to be more precise, you can move your mouse over your 

starting point and click when a small circle appears next to your mouse. 

 

14) Zoom out to see the whole selection. 

 

15) Leave the selection active (unless you want to go through all of that all over again) 
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5 -  Selection Masks 

Even using an advanced tool like the Magnetic Lasso or Quick Selection wonôt always give you 

perfect results. You may still have unwanted bits selected or there may still be important bits 

missing from the selection. You could use [Shift] and [Alt] along with the lasso tools to perfect 

the selection but that could be a little tedious with a complex image.  

In general speech, a mask is generally something you use to hide something. In Photoshop, a 

selection mask is used to indicate the parts of the image that are not selected. You can edit and 

refine a selection mask using your standard painting and drawing tools. Selection masks allow 

you to adjust the selection using your painting tools which is both easier and more precise. 

Exercise 9 ï  Editing a Selection Mask 

1) Click the Edit in Quick mask icon on the Tool Panel. 

 

The areas of the image that are not selected will now be shaded with a red colour (the mask). 

 

In some pictures, a red tinted mask might be difficult to see against the rest of the image but it 

can be set to any colour you want to make it easier to see. Itôs only for editing the selection and 

its colour will make no difference to the final image. 
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1) Display the Channels Panel. Remember that if a panel is hidden you can display it from the 

Window menu. 

 

You will see that the quick mask has been added to the channels panel. It is shown in italic text 

to indicate that it is only a temporary channel. 

2) Double click the Quick Mask channel in the list to show its options. 

 

3) Click the Color box to display the Colour Picker. Change the colour to one that will be easier 

to see against the rest of the picture (such as green). If you need you can also change the 

opacity option to adjust how much of the image will be visible through the mask though 

50% is usually a pretty good amount. Click OK to close the Quick Mask Options. 
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4) Select the Brush tool [B].  Make sure the brush opacity is set to 100%. 

5) Set the background and foreground colour to their defaults if theyôre not already [D].  

You can edit the mask by simply painting over it. Any parts that are painted over with black will 

add to the mask (add to the parts that are not selected). Any parts that are painted over with 

white will take away from the mask (add to the parts that are selected). 

6) Paint a line over the unshaded part of the image. 

7) Click in the Quick Mask icon (now the Edit in Standard Mode icon) to see the result.  

 

  Ą   

8) Return to Quick Mask mode. (you can press [Q] to switch between the two modes) 

9) Swap the foreground and background colours [X]  to make white your painting colour. 

10) Paint over the line you just drew to remove it. 

11) What follows is an exercise in painting. Zoom in on the image and neaten up the edges of 

the selection, using the following as a guide. Use your own judgement in selecting brushes 

and sizes. 

 

 

 

12) Return to Standard Editing Mode [Q].  

13) Save a copy of the image in Photoshop format [Ctrl] [Shift] [S] as portrait.psd. 

 

 

In this example, part of the 
hair that should have been 
selected has been missed. 
Painting over it using white as 
a foreground colour will 
uncover it (using a smaller 

brush is a good idea). 

In this example, part of the 
background that we donôt 
want was selected. Painting 
over it using black as the 
foreground will cover it with 
the mask so that it wonôt be 

selected. 
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Quick Mask Editing Tips 

¶ It can help to switch to standard mode now and then to see if youôve missed any bits as the 

selection marquee will make them easier to spot. 

¶ If you make a mistake while painting on the mask, simply swap colours again [X] and paint 

back over the mistake. 

¶ For any areas that you want to be slightly transparent in the final image (such as loose 

strands of hair), you can paint over them while the brush opacity is set to less than 100%. 

This will mean that those areas will only be partially selected and will end up being partially 

transparent. Just remember to change the opacity back to 100% before adjusting any more. 

¶ Carefully tracing around the some parts of the edge of the mask with the brush tool can 

make the selection a little less jagged, since the brush tends to have a smooth edge. It can 

take a lot longer but it can make a big improvement to the finished result. 

Ą     

¶ Using a softer edged brush will result in the borders of the selection being softer. In this case 

we probably donôt want that but in other cases that can be very effective. 
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Exercise 10 ï  Saving a Selection 

If youôve gone to all this effort to save a selection you wonôt want to lose it. We will make use 

of this selection in the Layers exercises so weôll save it for later. 

1) From the Select menu choose Save Selection (make sure you arenôt still in mask mode first). 

 

2) Enter Outline for the name of the selection and click OK. 

3) Deselect the boy [Ctrl] [D]. 

4) The saved selection is kept in the Channels. Check the Channels Panel to see the saved 

selection (channel). 

 

5) Click on the Outline channel to select it. The image will now show the selection mask. 

 


